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UIf Sjéstrand in memoriam

UIf Sjostrand, hedersmedlem, mangarig styrel seledamot och redaktor for
ABC-bladet har avlidit. Han avled hastigt och helt ovéantat i en hjartattack
den 26 juli. Ulf blev 62 . Han efterl amnar sambon Marianne Forsman,
aven hon hedersmedlem och tidigare kassor i klubben.

Det &r tack vare Ulf som klubblokalen ligger i Alvik. !

Jag traffade UIf forsta gangen i september 1980 nar han tog kontakt med

styrelsen for att tipsa oss om en lokal. Vi hade dai fleramanader sokt efter ,;/
en lamplig lokal. Kraven var att det skulle varaléatt att kommadit med tun-
nelbana och hyran var 6verkomlig. UIf arbetade — d& som fram till sin pensionering forra dret — som arkitekt pa
Stockholms stads gatu- och fastighetskontor och hade gjort ritningarna fér ombyggnaden av kommunalhuset i
Alvik. PAgaveln —Vidangsvagen 1, dar djursjukvarden nu haller till —fanns ett fonsterl 6st utrymme som han
trodde skulle passa. UIf adjungeradestill styrelsen med uppdrag att for en budget pa 10 tkr inredalokalen. Ulf
erbjod sig ocksd att | 6pande skota klubbens medlemsregister. Vid drsmotet 1981 valdes han till ordinarie leda-
mot och utsagstill sekreterare, en post han innehade i tre ar. Nar han |amnade styrelsen pa arsmotet 1984 ut-
sags han till hedersmediem och blev aktiv i ABC-bladets redaktion. UIf var redaktor for ABC-bladet fran1985
fram till borjan av ar 1997, mot slutet &ven ansvarig utgivare. 1989 aterintradde han i styrelsen och var kvar till
arsmotet 2000.

UIf var egentligen ingen programmerare men han hade skaffat sig en ABC-80 for att |&rasig och blev mycket
intresserad att anvanda den f6r administrativa uppgifter. Han fann stor gladje att med de primitiva program som
fanns pa den tiden klara de olika uppgifter som blev aktuella. Nar hans sambo Marianne blev kassor hjalpte han
hennei arbetet att 1agga upp och skéta klubbens bokforing pa data. Hans praktiska erfarenheter fran dessa syss-
lor gjorde att han blev en padrivare nar det gallde att utveckla de administrativa rutinerna for klubben och
ABC-bladet.

UIf var noga med att anl&gga ett moraliskt och etiskt betraktel sesétt pa olikafragor. Han tog initiativ till den
s.k. screeningen av insanda program sa att klubben inte utan medgivande skulle distribuera program som var
skyddade av copyright. Ulf forsokte alltid setill vad som var brafor allamedlemmar i klubben och slog vakt om
allméanintresset nér det kom propéer fran — som han uppfattade det — olika sérintressen. Som redaktér sdg han
till att det i ABC-bladet infordes M SG-utdrag s att informationen i klubbens konferenssystem gjordestillgang-
lig &ven for medlemmar som saknade modem. Han drev ocksa pafor att fafram pedagogiskt skrivnaartiklar for
den bredalasekretsen.

Gunnar Tidner <1306>, ordforande 1980 — 1984

Av UIf tecknade gjélvportrétt av arbetet
i redaktionen, héamtade fran omslaget till
ABC-blad 1985:1.
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ORDB, en antispamtjanst for mailservrar

Ingen spammer vill skicka spam frdn sitt eget mailkonto eftersom han dd med stor sdkerhet blir avstdngd av sin ISP.
Dd forséker de hitta en mailserver ndgon annanstans som de kan skicka via. De flesta mailservrarna som dr rditt

konfigurerade tilldter bara sina egna anvdndare att skicka mail via den. Tyvdrr finns det dock mdnga mailservrar som
inte dr ordentligt uppsatta och tilldter "tredje part” att skicka mail via dem. Dessa mailservrar kallas fér 6ppna relder,

eller open relays och dr alla spammers himmelrike.
ORDB:

ORDB &r en tjanst som skapar en databas tver ala de
mailservrar som &r open relays. Det fungerar pa sa sétt att nar
man tror sig hittat en mailserver som & en open relay anméler
man den pa ORDBs hemsida.

De lagger da upp den i en lista pa mailservers som den ska
testa och nagra timmar senare testar den alla pa listan for att se
om de relayar genom att via den mailservern forsoka skicka
mail fran sig gélv till sig gélv vilket inte ska fungera.

Ar IP-adressen en 6ppen relay |aggs ipadressen in i databasen
och ett artigt mail skickas till postmaster pa den mailservern
som nu spérras dar det star att de blivit sparrade och hur de ska
gora for att bli borttagna fran databasen.

ORDB ér ett idedlIt projekt och om man vill kan
man donerapengar till deras verksamhet.

Databasen:

Databasen 6ver open relays anvander sig av DNS. Om t.ex
10.0.0.1

skulle visa sig vara en open relay laggs ett DNS-entry upp som
1.0.0.10.relays.ordb.org pa deras DNS-server.

Nar ABC-klubbens mailserver far en koppling fran 10.0.0.1
gor den en DNS-uppslagning pa 1.0.0.10.relays.ordb.org och
om den adressen finns skickar mailservern tillbaka ett
felmeddelande till 10.0.0.1 och stanger ner kopplingen emot
den.

Inget test gors painnehdllet i mailet utan det &r enbart ett test
pa | P-adressniva.

Den 12:ejuni var det 197132 sparrade
mailservrar i ORDBsdatabas.

Effekt:

Sedan vi borjade anvéanda ORDB den 29:e mars har 6751
mailuppkopplingar frén dppna relayer hindrats. Hur manga
spam som vi dérmed sluppit kan man ju forestélla sig.

Vi har nu @ven borjat anvénda en andra liknande spérrtjanst
som heter VISI och den har hittils blockat 987 uppkopplingar
sedan den 5:e juni.

Negativ effekt:

Tyvérr kan flera av de mail som spérras vara mail som inte ar
spam eftersom ORDB och VISl inte skiljer pa mail och mail
utan enbart fran vilken server mailet kommer.

Sedan vi startade med ORDB har tvad medlemmar hort av sig
om att vanner inte kunnat skicka mail till deras ABC-konto. |
bada fallen har vi bett deras vanner att vanda sig till deras ISP
och klaga pa dem

Det &r synd att det ska drabba oskyldiga men forhoppningsvis
ar fordelarna 6vervégande.

Som mottagare far man inte reda pa att mail som skulle
kommit fram inte gjort det s det & upp till sdndaren att
kontakta dig pa nagot annat Sitt.

Vi & inte helt i handerna pd ORDB utan vi kan specificera
undantag i varan mailservers access-databas (inte MS Access ;).

Man anger undantagen per mottagare sa om du kanner att du
missar mail och hellre stér ut med spam sd kan vi laggain din
email i undantagdlistan. Vi lagger dain foljande rad i varan
access-fil:

To: du@abc.se SPAMFRIEND
Maila postmaster @abc.se om du vill std med pa listan.

Tekniken:

Det & valdigt enkelt att borja anvanda sig av dessa tjanster
eftersom tekniken som anvands redan & inbyggd i sendmail,
den mailserver som kors pa mail.abc.se.

(e N

Dessatvarader ar allt som behovsi
sendmailskonfigurationsfil:

FEATURE("dnsbl', ‘relays.ordb.org', "Rejected -
see http://ordb.org/")dnl

FEATURE( dnsbl', “relays.visi.com', "Rejected -
see http:/relays.visi.com/")dnl

S 4

Mer information om ORDB hitter du pa http://mww.ordb.org.
Mer information om VIS hittar du pa http://relays.visi.com.
Mer information om DNS baserade spérrlistor (dnsbl) finner
du pa http://mail-abuse.org/rbl

Gabriel <10723>

| ABCKOM finns manga intressanta méten. Ett av dom &r Antispam-motet.

Dér kan du diskutera om olikafilter, metoder osv. Ett vardefullt méte & min bedéomning.
Gamed du ocksd! Elisabeth <10892>

http://www.abc.se - Klubben f6r anvdndare av alla sorters datorer.
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MailWasher

Kampen mot ” spam” , skrappost, kan kénnas som ett hoppl 6st foretag. Gabriel Kihlman beskriver hér i
Bladet hur vara systemoperatorer forsoker hindra att skrépposten nar oss, men vill vi ha nagon e-post alls
kan de inte skruva at sarskilt hart. Vi mottagare maste gora slutsorteringen salva sa gott vi kan. De flesta e-
postklienter har idag funktioner fOr att filtrera och sortera brev, inklusive att identifiera och sudda en del
spam. Hur lattskétta och effektiva funktionerna &r varierar forstas.

MailWasher &r ett bade |attskott och avancerat program for
spamfiltrering, e-postkoll (mailcheck) och elementér virus-
varning. Det finns for alla MS Windows-versioner fran 9x och W ail Account
framat, och & nagware (dvs gratis, men sa lange man inte _ _ _
beelt misione 3 USD visesan - ioke lfr strande - e ot ok ot
tjatruta som paminnelse). Pa http://www.mailwasher.net/ far o

man utforlig information pa engelska, och kan ladda ner I AL

programmet (1,5 MB).

Account Details Ed

Server Information
MailWasher (MW) arbetar mellan e-postservern pa nétet och

e-postprogrammet i datorn. Det visar uppgifter om alla brev Email address: Im'l 234R@abe 32
man fatt - pd hur manga servrar som helst - analyserar dem,
och markerar spam, virus m.m. for vidare &gérd. Man kan till SMTP server address: |

och med riskfritt titta pa breven med programmet - &ven om de
innehdller virus!

POP3 server address: Imail.ahc.se

Installationen & automatiserad pd vanligt sétt, s& allt man till User name [POP3E {12345

en borjan behdver gora &r att lagga in minst ett e-postkonto o 4 POPIL
med menyvalet Tools>Account>Add. Undvik tillsvidare att o PURSE R
ange SMTP-adress - mer om detta senare. De forval program- [~ Bemember password

met installerats med &r forsiktiga, & det &r bara att kora.

[T Use secure authentication g =R e

| skérmdumpen har jag tagit med exempel pa de markeringar
MailWasher gor. For tydlighetens skull visas bara de viktigaste
kolumnerna; man kan fritt véjatill, och sortera, Till, An-
komsttid, Bilagor, Storlek, Kontonamn, Svartlistning, Van-
listning och Prioritet. Endast kolumnerna Radera och Studsa ok Cancel
(Bounce) & lasta.

¥ Include thiz account in default mail check

Radera (Delete) gor just det. Bocken séits dit automatiskt Account Details visar instéllning av konto.
utifran installningar man gjort, men valet kan ocksa andras for
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Satus ar den intressantaste kolumnen; dér visar MailWasher resultatet av sin analys.
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hand.

Studsa (Bounce) &r ett knepigare kapitel. 1dén & att man skall
skicka tillbaka ett brev som f&r avsandaren att tro att adressaten
inte existerar. MW bedyrar i sin "FAQ” att spammare inte har
en chans att se om meddelandet & falskt, men jag till&ter mig
tvivla. Sitter jag hos en viss | SP och forstker pasta att brevet
studsas frén en annan syns det i headern, och blir snarare en
bekraftelse pd att adressen var réatt. Dessutom & spammarens
avsandaradress ofta falsk, och d& studsas min studs tillbaka till
min Postmaster, som knappast torde uppskatta mandvern.
Gabriel beréttar att klubbens Postmaster rékat ut for diverse
sadana "felstudsar”.

Tror man verkligen att manovern har effekt finns den alltsa
dar, men mitt r&d & att man avstér frén den. | menyvalet
Tools>Blacklist>Options kan man ta bort bocken for "Mark
blacklisted messages for Bouncing”, men annu effektivare &r att
helt enkelt |&ta bli att ange ndgon SMTP-server for kontona - da
gér det inte att skicka nagra ” studsar” .

Virus

De forsta tva exemplen har MW markerat som virus, vilket
stamde. Det kan tyckas behandigt, men & inget att forlita sig pa
- efter det man tog hem versionen kan manga elaka finurlighe-
ter ha tillkommit utan att programmet har en aning om dem.

En finess fungerar dock altid: det & helt ofarligt att 6ppna,
eller réttare sagt titta pa, virussmittade brev med MW. Markerar
man brevet och trycker mellanslag (eller dubbelklickar) kommer
det upp som ren text i ett separat fonster.

P4 bilden visas ett brev med HTML-kod som normalt skulle dra

r_‘p o m m st ) Li iR a1 e

From: i <rokiiEnol sy siockhnim s es
DOmte; (206101 02
To: emmakeiEesulog

B0t Fovosim nissiiar, 0 el o nn s
M Dby full Poasechan e e sy Sacd s

C:omtand-Tramsies-Enscoding: qieoted-primsble =
=

< HTBL s HE AL HEAD < BOCY >

<livame arc=30cld WP L2402 helght=300 width=300>

< lfrade -

< PO T FOMT < BO0Y =< HTML>

-G P 2061340
ot Ty ausd infe-win;
name=hosdes zi3
Comtaiid-Trasnsfos-Erscodivg: baselil
Combend- ;<P L2440 =

TAAMAARAEAAAABAAL D ARARAAAAADAGARAAAAARABARAAARABARA
AAAMAARAABAAAAAS
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Bilden visar ett brev med HTML-kod som normalt skulle dra igang en
" mask’ (worm) av det 6kanda KLEZ-slaktet.

igdng en "mask” (worm) av det tkanda KLEZ-sl&ktet. <iframe-
raden skulle géra den osynlig, och raden nedanfér som borjar
med TVqQ tillhér sjélva programkoden.

Brevet &r redan Delete-markerat; det forsvinner fran servern
med menyvalet File>Process mail now, och kommer alltsainte
hem till datorn vid ordinarie posthdmtningen.

Blacklisted

Vanlig svartlistning & sddan man bestamt gjalv, antingen
genom att trycka - (minus) nar brevet & markerat, for att fa med
hela avsandaradressen i listan, eller genom att ange villkor i

6
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Tools>Blacklist.

Jag har svartlistningsvillkoret *mail.com, som bl.a. técker allt
frén hotmail.com. Och s har jag med mailer-daemon@abc.se,
eftersom deni nio fall av tio &r falsk :-)

Origin blacklisted

Har har MailWasher samma metod som Gabriel Kihlman
redogor for i sin artikel om spambekampning pa servern. MW
kollar ocksd mot officiella svartlistor, och markerar brev fran
doméner som forekommer i dessa. ORDB och VIS, som
klubben anvander, finns med frén borjan, men eftersom
servern redan tagit hand om sddana brev kommer de inte fram
till véra brevlador. MW har dessutom SpamCops lista, som &r
mer aggressivt upplagd - kdrde klubben den skulle vi nog
missa en hel del brev.

Men hér far vi ju se vad som & delete-markerat, och kan
alltsd sjdva avmarkera eventuell overkill. Man kan lagga till
andra svartlistor, MW namner flerai sin FAQ.

Nor mal

Dessa brev uppfattar MailWasher som harmlésa, men det
behover forstas inte altid stamma. Visst luktar "FREE NEW
Cars for the Taking!” spam lang vag? Trycker jag minus pa
brevet hamnar avsandaren i min svartlista.

handla@négon maste val ocksa komma fran en kramare;
hur mycket jag an sympatiserar med Réttvisemarkning ar det
spam, eftersom jag aldrig bett dem skicka mig négot. Ovriga
normalmérkta, som inte visas hér, &r fran vanner, bekanta, och
andra acceptabla korrespondenter.

Skulle man viljata emot brev frén ndgon som sander fran en
svartlistad doman, lagger man in adressen i "vanlistan”
(Friends list). Suddnings- och studs-bockar forsvinner da
automatiskt fran dessa brev.

Man maste inte nddvandigtvis kolla vartenda brev, det gér bra
att |1&ta MW automatsudda allt Delete-markt. Da f&r man
skyllasig éalv - det kan ju faktiskt komma ett godtagbart brev
frén en hotmailadress till mig, hur otroligt det an 1&ter!

| sin grundinstalining fungerar MailWasher bra, men haller
sig pa den sikra sidan. Careful & forvalt; jag skruvade genast
upp till Strong. Man kan |&tt vassa programmet, inklusive att
stéllain specidlafilter ungeféar som i vanliga e-postklienter.
Givetvis kan man stéllain det att automatiskt kolla brevl
dorna med bestdmda intervall.

Nackdelarna d&?

Programmet arbetar ratt [angsamt, och kan knappast rekom-
menderas till den som ofta har flera hundra brev i sina
Inboxar. Under hundra & det acceptabelt.

Jag har under ett par veckors daglig anvandning haft 2-3
hangningar av min W98SE som jag misstéanker MW fér. Bevis
har jag inte, det & sd mycket som kan hanga M S-operativsys-
tem.

Fordelarna dvervager. MailWasher ar ett mycket bekvamt
program for koll av méttligt trafikerade e-postlador!

Clarence Ekman <10493>
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Utnyttja tjansterna pa windows.abc.se

Sedan i vdras finns det mdjlighet att utnyttja foljiande tre tjdinster pd windows.abc.se: domdnparkering, e-post-
vidarebefordran och dynamisk DNS-tjdnst. Samtliga tjdnster kréver att du forst och frdmst har ett konto pd
windows.abc.se. Du ansbker om ett konto pd http://windows.abc.se/konto.

Vad kan du anvanda dessa tjanster till?

Doménparkering

Du har registrerat en egen domén (I&t osskalladen
domain.xyz) och vill nu publicerawebbsidor paden. Enk-
last kan du da anvandawindows.abc.se som din personliga
webbserver. Dinavanner slipper dakommaihdg trakiga
URLer som http://windows.abc.se/mXXXX eller &nnu varre
http: //windows.abc.se/~mXXXX. Handen pa hjartat hur
mangavet egentligen var ~-tecknet sitter patangentbordet?
Istéllet anvands det mer professionella http: //
www.domain.xyz som &r bade |&ttare att kommaihag och
ser meraprofessionel It ut.

For att det skafungera maste du goraféljande:

Du maste forst och framst ange windows.abc.se
195.17.72.8 och windows2.abc.se 195.17.72.58 som dina
nyaDNS-servrar. Dettagor du hos den myndighet eller f6-
retag som har hand om ditt doméannamn.

Dérefter kommer http://www.domain.xyz att peka ut din
webbplats pa http://windows.abc.se/mX X XX X. Du kan
anvanda ftp (ftp://windows.abc.se) eller Front Page Server
Extensions (mMXXXXX) for att uppdatera webbplatsen.

| dagslaget har olika medlemmar redan registrerat domé:
ner under .COM, .NET, .ORG, .US, WS, .NAME och .NU.
SE-rotdoméanen hanteras av NIC-SE Network Information
Centre Sweden AB. NIC-SE har inte godkant
konfigurationen av vér DNS-server och darfor kan .SE annu
inte anvandas. Tyvarr kraver en omkonfiguration av var
DNS noggrannaforberedel ser. Detta & orsaken till att vi
som ansvarar for windows.abc.seinte har hunnit med det.

E-postvidarebefordran

Né&r du nu har satt upp en webbserver till domain.xyz vill
du sdkert kunnataemot allae-brev som skickastill
domain.xyz.

Du kan skapa alla ténkbara e-postadresser inom
domain.xyz doménen somt ex Mitt. Namn@ domain.xyz,
Gud@ domain.xyz, Satan@ domain.xyz, VadSomHel st@
domain.xyz, NuK anJagl nteMinnasFleraExempel @
domain.xyz. Allae-brev som skickastill domanen
domain.xyz kommer helt enkelt vidarebefordrastill dinvan-
liga ABC-adress mXXXXX@abc.se.

Pasikt kommer vi &ven tillata vidarebefordran till andra
e-postadresser &n din ABC-adress. E-postvidarebefordran
fungerar inte med underdoméaner somt ex
namn@hemma.domain.xyz. Finns det stort intresse fran
varamedlemmar kan den funktionen |ggastill i framtiden.
Dynamisk DNS-tjanst

Hur skadu gatillvaga om du vill séttaupp en egen
webbserver och kanske en egen mail-server hemma? Du
kanske har en fast internetuppkoppling hemma med dess-
varre dynamiskt tilldelad | P-adress.

Daar var dynamiska DNS-tjanst |sningen. En dynamisk
IP-adress skaju inte hindra dig fran att sitta upp egna
servrar hemma som skakunnanas viaditt egenregistrerade
doméannamn. Dessutom avlastas windows.abc.seom du
lagger ditt innehdl hemmaistéllet for pAwindows.abc.se.

For att tjansten E-postvidarebefordran skafungerahar jag
i DNS-servern redan lagt till en host (A-record) som heter
mail (195.17.72.8) och en mail exchanger (M X-record)
mail.domain.xyz.

Du kan gérna andrabadaom du t ex vill sétta upp en egen
mailserver. Men kom ihag att tjansten E-post-
vidarebefordran viawindows.abc.se endast fungerar med
dessaoriginainstallningar.

Du kan nu manuellt [aggatill och &ndra dina DNS poster
pa https: //windows.abc.se/ChgDns/Form.asp. Pa sikt kom-
mer dennafunktion finnas under " Min Profil”. Pasikt kom-
mer det ocksa finnas majlighet att ta bort poster.

windows.abc.se

Datorn windows.abc.se & en Pentium 3 som korsi 800
MHz med 256 MB Ram. Utrymmet pa harddisken som kan
anvandas av medlemmarnar pa 15 GB. windows.abc.se
och w.abc.se & sammadator. Operativsystemet som an-
vands & Windows 2000 Server.

D& hela systemet pawindows.abc.se fortfarande & under
uppbyggnad (kommer att vara sd under |8883ang tid :-) )
kan ni rapportera eventuellabuggar, synpunkter och kom-
mentarer direkt till mig.

Eftersom jag inte heller har hunnit skripta allaadministra-
tivauppgifter utan gér vissa saker manuellt kan det handa
att jag har missat ndgot steg. Ha 6verseende om det inte
fungerar som det borde. K ontakta mig sd skajag goramitt
basta for att réttatill felet.

Lite statistik

| dagsl&get har 85 medlemmar sin webbplats pa
windows.abc.se. Av dessa har 10 medlemmar valt att par-
kera 24 domaner.

Tjansteansbkan

Nér du har skaffat ett konto (http://windows.abc.se/konto)
kan du ansoka om de olikatjansterna pa

(https: //windows.abc.se/profil).

Detlef Hahn <9039>
WindowsMaster @abc.se
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Att gora ett objekt i 3D

Att gbra 3D effekter dir skoj och resultatet brukar bli bra. Det finns mdnga variationer med belysningar,
skuggor och olika ménsterfyllningar. Det roliga dr att det dr hur Idtt som helst att skapa en proffsig
text. Hdr provar jag att gbra en mjuk 3d text. | detta exempel har jag anvdnt mig av verktyget

"mask”.

4 Borjamed att skapaen ny bild.

Hér har jag valt en vit bakgrund.
Marnn: |AEIC (o8 |
— Storlek pa bild: 3.67W —— Aterstall |
Eredd: |El | o =
HiEjd: |4 | cm =l
LIpplgsning: IZDD | pixlar scrm j
Lage: | RGE-farg |
— Innehall
o itt
™ Bakgrundsfarg
" Genomskinligt

2 Senskapar jag ett nytt lager. (Menyraden, visa

lager). Klicka sedan palagerrutan

Lager “ Kanaler ™ Banor b

|Morrmnal =] Opacitet: i1I:II:I l-i 4

[ Bewvara qenornskinlighet

B | e ______ |

IE ||_ Sadagevmnt

#
S

3 Vi (Textverktyget) och skapaen mask pa det
tommalagret (Lager 1)

.

LAY

i
B dhb,

| VR
[_'17'3;:

a N
1=

| &
=
20
@+
AE |

(5] ]

8

4 Vaj ett runt typsnitt. Effekten blir béttre d&
Hér har jag valt Lucida Fax.

Teckeran#: [ Luciis Fo Fl| Reguter X o ]
Giorkk [75 | ueter =) Badneting | et

kemig [ T =EE
Baing 0

M auto-teming = achtfamning T

AbL

3] 7 Sepansdifmretr 1] |

B Jag fyller minmask i mellagréit dbladet
trycksi svart/vitt :-) . Det blir béttre effekt om
man anvander en farg som det gar att gora bade
ljusare och morkare.

Nér du fyllt din mask sagéar dutill menyn
(Markering)och(Omvéand). Dakommer allt att
markeras utom texten. | det hér fallet ABC.

M amninct-§ 2 100T |Lager 1 HEE)]

6 Kanterna patexten ska nu goras 100% morkare
och sedan 100% ljusare.

V| i menyn (Markering) sen (Ludd).
2 pixlar brukar bli enlagom mjuk 6vergang.

Luddmarkering

Radie pd ludd: IE pixlar
byt |
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7 Markerasedan lager 1 och med piltanjenterna 4 Q Senérdetfritt fram att |&ggatill skuggeffekter
flyttar du tva steg ner och tva steg till hoger.

Nu har du markerat den nedre hgra delen av din e
text.
GAasen till menyn och vaj (Bild) , (3l in), och | [ Awfasning och reliet =] ¥ anving
sen (Intensitet/kontrast). — Haodager Aterstall |
Stél in Vérdet +100 pa Intensitet och 0 pékontrast. Lge: [ Raster =] cevegience |
Nu blir det [jusare gratt inuti masken, den &r ju Cpacitet: [75 3E: - |
aven flyttat lite nerdt till hoger satexten f&r en e L5
mijuk ljus 6vergaende underkant. * ¥ Férhandsvisa
Lage: | Lumniniscens =l .
Cpacitet: m %
Intenzitet/kontrast | stit: [ e aviasnng =]

Intensitat: | (74 I Angle: |120 ¥|® ¥ anvand global vinkel

I I 2 Arstal] | Bitar: |5 plpi}{lar & lUpp © Med

kontrast: ||:| Dskarpa: |5 » I pixlar

' -+ ' ¥ Edrhandsvisa
Gor samma moment en gang till fast nu at mot- 41 Det fardiga resultatet blev vél bra?
sattahdlet. Nu &r det bara att prova sig fram.

Med piltangenten gar du 4 steg &t vanster och 4
steg nedét och véjer (Bild) , (Sall in), och sen
(Intensitet/kontrast).

O stall vardet p&+100. Nu far du en mork effekt i
mitten paresp. font. Ditt arbete skall nu se ut ung
sahar.

Lycka till

Elisabeth <10892>

Manusstopp for ABC-bladet nr 4 ar
den 17 november

Har ni material som ni vill publicera, skicka da det i .txt eller .rtf format.

Foton och teckningar i TIFF-format (.tif) eller JPEG-format (jpg) med LZVW-komprimering.
Skarmdumpar dven dom i LZW-komprimerad TIFF.
Adressen ni skickar ert material till ar red@abc.se
Aven 6nskemal om kommande artiklar skickas till samma adress.

Elisabeth <10892>
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Elektroniska missforstand

Jag har anvdnt elektronisk kommunikation sedan bérjan av | 980-talet. Det dr mer dn 20 dr nu. Med
elektronisk kommunikation menar jag e-post, e-postlistor, USENET News och konferenssystem av

KOM-typ som LysKOM eller QZ-KOM.

Det finnsratt mycket elektronisk kommunikation i
ABC-Klubben mellan demedlemmar som l&ser och
skriver i ABCKOM, dvs. ABC-KlubbensLysK OM -
system. Dock maste man komma ihag att det finns
medlemmar som inte diskuterar i ABCKOM utan
som kanskepasin hojd skriver ett e-postbrev ndgon
gang och inte mer.

Jag har sett en hel del problem med elektronisk kommu-
nikation, inte bara inom ABC-klubben utan &ven i andra
foreningar.

Jag tycker mig se ett monster som gér ut paatt det i manga
fall kan bli missforstand och brék pa grund av mediet.

En del uppfattar de har bréken som dlvarligare an vad
man kanske borde gora. Det tror jag beror pa att
diskussionen sker i skriftlig form. Det blir lite svart pa vitt,
dvs. att det tolkas hardare an en muntlig diskussion.

Né&r vi kommunicerar muntligen med nagon eller nagra
personer saforstar mottagaren ganskasnabbt vad man menar
eller inte menar. Missforstand réttas snabbt till. Vid en
elektronisk kommunikation tappar man kopplingen mellan
personen som skriver och den som |&ser.

Dennakoppling sker vid en muntlig kommunikation genom
séttet att tala och genom kroppssprak. Man kan siga négot
och genom att sedan bara le sa far man omgivningen att
forsta utan att man ens behover sigaett ord. Dettafungerar
inteallsvid elektronisk kommunikation.

Om man skriver nagot som nagon uppfattar somtokigt eller
mycket fel kan en uppriktig kommentar uppfattas som ett
kraftigt pahopp. Skulle ndgon séga samma sak muntligen
skulle framstallningen anpassastill mottagarens reaktion som
i deflestafall inte uppfattat det som nagot pahopp alls.

Det ar stor skillnad pa erfarenheten av elektronisk
kommunikation mellan olikapersoner. Tyvarr framgér detta
intealsi mediet panagot satt. Har blandas erfarna personer
som har kommunicerat via dator i 10 eller 20 & med
nyborjare. Har blandas ocksa gamla och unga utan att det
framgar i diskussionen vilkasom &r yngre eller ddre.

Det framgar inte heller om nagon har nagot handikapp i
négon form. Ordblindhet kan gora att folk kommer med
petiga tillréttavisningar som om det gallde ett manus till
nagon viktig skrift ochinte en diskussioni el ektronisk form.
| varsta fall kan en diskussion urarta s att den enda
synpunktentill texteninskranker sig till uppgifter om stavfel.

10

v Bild Mikael Lindberg <8601>

Kan man da|6sa problemen med el ektronisk diskussion?

Det & svart, men man kan forsoka. Egentligen tror jag
inte att en elektronisk diskussion mellan olika personer
altid kanfungera. Man far nog réknamed att folk kommer
snett i en sadan diskussion. Skriftlig kommunikation &r
svart.

—

Forst och framst méaste de som laser inte alltid utga fran
att det forsta intrycket av texten & samma sak som vad
skribenten avser. Dvs. tolkningen av texten maste bli vad
personen menade och inte vad han eller hon lyckades skriva
ner vid tillfallet som texten skrevs.

De som skriver méaste tanka pa att lasarna kan uppfatta
textenfel och forsokavaratydligaochintei onddan trampa
pa 6mma tar. Man bor ténka pa att undvika saker som
nagon kan tankas blir uppretad Gver, &ven om det &r svart
att forutse folks reaktioner.

Forstameningeni entext ér viktig. Om budskapet &r viktigt
sa bor man enbart ha ett budskap i en text for att gora det
tydligt for |&saren.

Sa kallade Smileys av typen :-) kan anvandas for att
indikeraskémt, men man kaninte alltid réknamed att alla
forstar sadana tecken.

Bo Kullmar <1789>
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E-postlistor

Ett gammalt scitt att kommunicera 6ver Internet dr e-postlistor, eller mailinglistor som de ofta kallas pd
ren svengelska. Vdr svenska datatermgrupp http://www.nada.kth.se/dataterm/index.html

foresldr att vi skall kalla dem sdndlistor. De skiljer mellan personliga scindlistor ddir en person skickar
meddelanden till mdnga och allmdnna scindlistor ddr alla kan kommunicera med alla.

Welcome!

List

S HC-Nar

£

- -+ =R A, o O ® F | S - A
Jigpp  Uppdstma SJimbads | 9ok Favodw  Hads  Tibgew | Epad  Gkevul  Fadges  Diatua
Agherez [ ] apbsts sbe st ik =] Rt | Linka ™
bele.abe.se Mailing Lists [

Eelorw is & bistirgg o all the parblic maikieg kste on bale abs se. Clhck: on & bt name b get mora nformation about the b, o0 4o subecnbe, unmbscoba, and changs
thes preferences on your sobsenpbon. To v the odo page for on nadveried kst, open o UEL savader to dus 2ae, butwitha ¥ and the 5t oane apperndsd

List ademintotrabers, Wl can wert e Bt sdmn overnew page to fnd The oo geoent nbedace for goor st
(Send questicns or conments to madman-cwmeniiibele abe s

Description
disknssioner om Macmkosh

RATATT LI

llﬂt manager

- M Moy homre: prge
:IGIJJEF.-IFJEH- : ' |.l|:|||:.|'| liciies
sd:_Lh.-mu.m
W= =

B e

Jag maste erkanna att jag inte
sett begreppet sandlista anvan-
das sar skilt ofta

- och kommer gélv att fortsatta
anvanda begreppet e-postlista

- men en stkning pa Google
http://www.google.com visar att
det fatt ett visst genomslag.

Om nu begreppet sandlistainte redan var
upptaget hade det kunnat karaktériseravad
datatermgruppen kalar personliga sdnd-
listor. En person eller organisation sander
ut e-postmeddelandentill mangapersoner
efterenlista

Det kan goras i ett vanligt e-post-
program eller direkt i en server. Ofta
handlar det om nyhetsbrev som féretag
sander ut till kunder och andra intres-
serade. | &rlighetens namn maste man
erkdnna att oonskad e-postreklam till-

hor den hér kategorin.

Ett braexempel & annars ABC-klub-
bensegen e-postbulletin” ABC-bullen”.
| det fallet sdnder Johan Perssonut ABC-
bullen till klubbmedlemmarnas e-post-
|ador viaklubbens Unix-system.

Om négon svarar paen ABC-bulle gér
svaret till redaktoren
bullen@abc.se som & undertecknad.
Kommunikationen sker en till manga,
ochibland tillbakatill en.

Allmannasandlistor skulle kunnakal-
las diskussionslistor dade nastan alltid
anvandsfor diskussioner. Iblandi fraga/
svar-form, ibland fOr att ge varandra
stod, ibland for att dryfta olika asikter
etc. Precis som samtal i var vardag kan
de handlaom allt mgjligt.

Grunden for en diskussionslista &r att
en prenumerant skickar ettinlégg i form
av ett e-postbrev till enlistserver.

Listservern skickar sedan ut inlégget till
dla som prenumererar pa listan. Om n&
gon kénner sig manad att svara skickar
dennein ett svar till listservern som snder
ut svaret till allasom & med palistan.

Varpa ngon &ter kan svara... osv.

Precissomi andrasocialasammanhang
blir en diskuss-iondlistatill det medlem-
marnagor den till. Nastan, for det finns
olikasdtt att organiseradiskussiondlistor.

Varjee-postlista”ags’ av en”listmom”
som skoéter listan och ser till att
prenumeranternafdljer deregler som gal-
ler. ”Listmom” har makt att taprenume-
ranter som misskoter sig i orat och kan
rent av stdngaav dem.

Endel e-postlistor &r privata, vilket inne-
béar att man maste skrivatill ”listmom”
for att fabli prenumerant.
Andrae-postlistor &r offentliga, dabru-
11
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Exempédl padessaér:

YD Postainte bilagor eller e-post formaterad i html-format.
Det finns givetvis e-postlistor som tillater detta, men de &
annu salangefa Padeflestae-postlistornavill prenumerante-
rnalésaren oformaterad text.

Postaintereklam eller kommersiellatillkannagivanden.

Postainte virusvarningar, eller kedjebrev. | mangafall
kan de vara samma sak, dar varningen & sjdvaviruset.

Y8 Posta inte material frn andra om du inte har tillstand.
Angeistéllet enlank om texten &r tillganglig pa Internet.

Postainte”Meto”. Brainlagg kan det varamanga som

instammer i varpadet blir en massainlagg somingen egent-

ligen & intresserad av att |asa. Fundera istéllet pa om det

inte & battre att skriva direkt till den som postat ett inlagg.
Det galler &ven svar pa andra typer av fragor.

Och nér du besvarar ett inlagg - citeramed métta. Klipp
bort allt onddigt, framfor allt signaturer.

kar det réckamed att skickaett e-brev till listservern for att
bli prenumerant.

Numeraar det vanligt att man kan startaen prenumeration
paen e-postlistavia ett formul & pa en webbsida.

Begrepp som 6ppen och duten anvandsibland synonymt med
offentlig och privat. For det mesta menas samma sak, men
en sluten e-postlistakan mycket
va varaoffentlig i sd motto att ”listmom” i praktiken |ater
alasom vill varamed fa en prenumeration. Om en e-post-
lista & sluten eller Gppen avgors av huruvida prenumeran-
ten sjdv kan starta eller avdluta sin prenumeration. | vissa
arbetsgrupper, t.ex. ABC-klubbens styrelse, blir man adde-
rad till en e-postlistaoch kan inte ga ur den med mindre an
att " listmom” tar bort adressen.

Den listan ar sdledes bade privat och sluten da bara
styrelsemedlemmar kan vara med och da de inte kan pa
verkasin prenumeration géva.

For det mestagér allameddel anden paen e-postlistauti sin
helhet och ”listmom” ingriper barai efterhand, t.ex. om dis-
kussionen kommer allt for [angt fran amnet.

Paen del e-postlistor har man forsokt héjakvalitén pade-
batten genom att moderera den. Dettainnebér att alla med-
delanden gér till en moderator som sedan skickar ut dem till
prenumeranterna. Det kan ses som en censur och innebér
ibland baraatt moderatorn forhandsgranskar inldggen innan
de gér ut till e-postlistans prenumeranter.

Men man kan ocksa se det som en redaktionell uppgift dar
moderatorn klipper bort ovasentligheter ochi vissafall lag-
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ger till egnakommentarer och svar direkt i inlagget.
Ofta innebér det att debatten fokuseras och att kvalitén
hojsvésentligt.

Varje e-postlista har sina egna regler och man goér klokt i
att 1asa igenom dem innan man ger sig in i debatten. Ofta
stér reglernai valkomstbrevet. Det brevet & braatt sparada
det &veninnehdller information om hur man avslutar en pre-
numeration. Men som redan skrivits, det blir alt vanligare
att all information géllande en e-postlista finns pa en
webbsida

Aven om reglerna skiftar sa finns det en del regler som
utkristalliserats som en allmén praxis och nétetikett for
e-postlistor.

Det finns forstads mycket mer att berétta om e-postlistor.
Den viktigaste just nu & dock att klubben har satt upp
Mailman http://mww.list.org, en e-postlistserver.

Tanken &r att vi skall skapa négra privata, men inte utna
e-postlistor for ABC-klubbens medlemmar, samt att ABC-
klubbens medlemmar skall kunna skapa och administrera
sina egna e-postlistor. Som vanligt har funktionérerna en
stark vilja, medan de ideella krafterna & svaga.

Vi tar dock nyatag under hosten och dterkommer med in-
formationi kommande ABC-blad ochi ABC-klubbensegen
e-postbulletin” ABC-bullen”.

Till dess rekommenderar jag att ni letar e-postlistor pa
http: //www.kanalen.org, http://www.topica.com,
http://mwww.yahoo.com och http://segate.sunet.se/

Per Styrenius 9845

Den 17 november ar det
manusstopp for tidning
nr: 4.

Lamna in eventuella
manusi god tid.
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Nagra ord fran Tommy, kassoren i klubben.
Anvdnder du klubbens modempool i onédan?

Flera fragor som inkommit till funktiondrer tyder pa att det inte dr helt solklart ndr
uppkoppling via var modempool dr nédvéandigt Atskilliga ér de medlemmar som pa senare tid
| skaffat bredband i nagon form. | samband med detta slutar de att anvinda mailadressen pa

klubben och &vergar till att anvdnda sinbredbandsleverantérs mailadress